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 ، کدام دستورزیر استفاده می شود؟  word ءبرای درج علائم ویژه درسندهای برنامه -12

  insertsymbol -د                insertBullet -ج             insertcharacter -ب          insertformat -الف  

 

 قلم ، موجب ایجاد یک خط افقی بر روی متن می شود؟ ءکدام جلوه ویژه -11

 SuperScript  -د               Shadow -ج          Double Strikethrough-ب          Strikethrough-الف 

 

 

 رود؟ می کار به اعشار ممیز همترازی برای tab کدام -12

   -د                        -ج                                          -ب                              -الف  

 های الگو کدام است؟فایل ءفرض برای ذخیرهپیش ء پوشه -12

 My network places -د        Desktop  -ج                          My document -ب                Template -الف  

 

 استفاده می شود ؟ فایلهای پشتیبان از کدام گزینه ءبرای تهیه -12

 ميشوند؟ ذخيره فرمتي نوع چهبا  word 2007در  فرض پيش صورت به فايلها -1

  ) Dotx د Xlwx                                     )ج) Doc                                ب Docx                          (الف 

 چيست؟ کند مي ادغام هم در را ها سلول که دستوري نام -2
 Mix (د                  Combine (ج   Add (ب  Merge & Center (الف

 استفاده مي شود؟Powerpointبراي ارايه  نمايش از کدام يك از نماها در  -3

 Slide Sorterد(                Note Pageج(   Slide Show (ب              Normal الف(

 شخصي سازي جلوه هاي متحرك  با چه ابزاري صورت مي گيرد؟ -4

  Custom Animation(د                    Transition Soundج(      Animateب(  Transition Speedالف( 

 ميشود؟ استفاده آنفيلد براي گزينه کدام از شود، ظاهر انتخابي ليست فيلد، يك براي اطلاعات ورود هنگام که بخواهيد اگرaccess در  -5

 OLE object د(             Memoج(     Look upب(      Textالف(  

 واژه پرداز



 Always Create Back Up Copy( ب                        Save Auto Recover                                الف(   

 Save And Back Up( د                                                            Always Fast Saveج(    

 

   26- Which tool in the picture toolbar is used to create transparent areas in a picture?    

                                                 a.                    b.              c.                   d.    

 

 

 یک اسلاید جدید ایجاد کرد؟   تواننمیاز کدام روش ،   - 12 

   ءدکمه    homeاز زبانه -ب      New slide ءکلیک راست روی اسلاید گزینه –الف  

 ctrl+Nکلید میانبر   -د                                      Ctrl +Mکلید میانبر  -ج   

 

 ایجاد نمود؟   هانتخاب شداسلایدهای می توان یک اسلاید خلاصه ازعنوان سایر  Outliningبه کمک کدام ابزار در نوار ابزار  -12 

  -د                                     -ج                     -ب                             -الف   

 

 استفاده می کنیم؟ Drawingواقع بر نوار ابزار  Drawمنوی  ءبرای هم ترازکردن دو یا چند شیء، از کدام گزینه -12 

  Set Auto Shape Default -د       Align Or Distribute   -ج            Rotate Or Flip  -ب           Order -الف  

 

 فاده کنیم؟در صورتی که بخواهیم  به هر شیء در اسلاید نوع خاصی از متحرک سازی را مطابق سلیقه خود اعمال کنیم ، باید از چه نوع متحرک سازی است -23

 Custom animation -د         Animation schemes -ج    Slide sorter -ب       Slide Transition -الف   

 

 

              31-Power point uses ..........  to create a chart; that Software install with power point. 

                                                                            a. Microsoft office                         b. Microsoft graph   

                                                                                           c. Power point viewer           d. Microsoft excel 

 

 

 

 صفحه گسترده

 ارائه مطالب



 شود؟های انتخاب شده در قالب درصد بیان میهای برگه ، اعداد سلولبندی سلولدر کدام نوع قالب -21

 Number -د                 currency -ج                         Fraction -ب                percentage -الف 

 

 کنیم؟ استفاده می  Styleکار جاری استفاده کنیم ،از کدام دکمه در پنجرهء  ایم، درکتابهایی که قبلا در کتاب کارهای دیگر ایجاد کرده styleاگربخواهیم  -22

  -د                -ج                       -ب                   -الف  

 

 های حاوی اطلاعات با یكدیگر ...........در هنگام ادغام کردن سلول -22

 شود. ها  میهای سلولاین عمل باعث از بین رفتن دادهشود که  به  کاربر هشدار داده می-الف  

 موجود در اولین سلول ادغام شده، درسلول جدید باقی می ماند. ءفقط داده -ب  

 شود.                             پیام خطایی مبنی بر عدم امكان عمل ادغام ، صادر می -ج  

 الف وب هر دو -د   

 

 کند؟عمل می formatازمنوی  cells ءمعادل گزینه formattingر کدام ابزارازنوارابزا -22

  -د                        -ج                                  -ب                        -الف   

 

 بر روی کاربرگ روبرو کدام است؟ count(A2:C3)=حاصل اجرای  تابع   -23

                               

          6 -ب                                                        3   -الف 

 value# -د                                                       10    -ج   

 

   37- Which one is the way to view format cells?     

           a. Ctrl+F1                                                               b. Ctrl+F2 

           c.  Ctrl+1                                                                d.  Ctrl+2 

 

  

 

 سریعترین روش برای ایجاد گزارش کدام است ؟ 38-

 بانک اطلاعاتی



  Label Wizardد(  Report Designج(  Report Wizard( ب  Report Toolالف(

 

 ؟ نیستفراهم   Designکدام امكان در نمای  -22

 تعیین فیلد کلیدی  -ویرایش رکورد              د -جابجایی فیلدها                        ج  -تعیین ایندکس            ب -الف  

 

 پر شود، ................ Yesبا مقدار   Requiredاگر هنگام طراحی جدول ، ویژگی  -23

 قانون صحت باید بررسی شود .   -ترتیب پرکردن فیلدها یاید رعایت شود .                          ب  -الف  

 این فیلد قرار بگیرد.تواند در ای به طول صفر نمیرشته  -کاربر باید این فیلد را وارد کند.                                       د  -ج  

 

 "معدل"(  داشته باشد ، این شرط را در مقابل کدام ویژگی فیلد 13اگر بخواهیم فیلد معدل مقداری بین ) صفر تا  -22

 کنید؟وارد می       

 Smart Tag  -د                  Default Value  -ج           Validation Rule -ب           Validation Text -الف  

 

 شود..........در پایین  فرم ، باعث می   دکمه  -21

 فقط اطلاعات رکورد اول روی فرم نمایش یابد.  -الف

 پس از نمایش اطلاعات رکورد آخر ، امكان ویرایش آن فراهم شود. -ب 

 پس از نمایش اطلاعات رکورد اول ، امكان ویرایش آن فراهم شود.  -ج 

 پس از نمایش اطلاعات رکورد موردنظر، امكان حذف آن فراهم شود. -د 

 

 را حذف کرد؟  Filter By Selectionتوان ، فیلتر از نوع به وسیله کدام گزینه می -22

   -د                                 -ج                                   -ب                                   -الف

 

 ، کدام گزینه  Criteria، در بخش   نیست، کلیه رکوردهایی باشد که شهر آنها  تهران  Queryاگر بخواهیم نتیجه  -22

 باید نوشته شود؟      

    > "تهران  "  -د                 >< "تهران  "  -ج                 Like "تهران  " -ب                   # "تهران  "  -الف  

                                                                                    

                                                                   How Do You Run a Query? 22 -                                                                                         



               .d            .c          .b                    .a 

 

 1332wordواژه پرداز   

 برای اعمال تورفتگی به سطر های دوم به بعد یک پاراگراف کدام گزینه مناسب است؟ -23     

  Format painterد(                         Hanging indent(ج                   character spacingب(           first line indentالف(           

 از کدام دکمه استفاده می شود؟ Tabبرای حذف تمام نقاط   -22    

 Cancelد(                                              Setج(                                       clearب(                       clear all( الف           

 انتخاب می کنیم؟  line spacingدر صورتی که بخواهیم فاصله ی بین سطر های یک پارگراف را سه برابر کنیم، کدام گزینه را از  -22   

  Multipleد(                                 Doubleج(                               line 1.5ب(                              singleالف(             

 کدام دستور،  ستون های جدول  را حذف می کند؟  -22

 Delete Columns( د                    Delete Cellsج(                    Delete tableب(                 Delete Rowsالف(      

 برای کار با ماکروها،  از کدام زبانه استفاده می شود؟  -13

  Developerد(                        Referencesج(                             Insertب(                             viewالف(       

 ی شده کدام گزینه است؟منظور از پاکت های آدرس ده   -12

 Directoryد(                           Envelope (ج                                labelب(                            Letterالف(     

 22-  Before of printing a document we need …………….. 

  Office buttonد(                   Print preview( ج                               Printب(                    Quick printالف(     

 Excelصفحه گسترده 

 ، کدام کلید باعث افزایش مقادیر  عددی می شود؟  Autofillهنگام استفاده از   -12

 Tabد(                                     Ctrl( ج                                Altب(                                Shiftالف(     

 ، اعداد وارد شده را به صورت درصدی نشان می دهد؟ Home، از تب  Numberکدام گزینه در گروه  -12

 fractionد(                            Scientificج(                     Percentage( ب                      Currencyالف(      

 برای گرد کردن اعداد ، از چه تابعی استفاده می شود؟ -12

                         Countد(                                       fixج(                            Round( ب                               INTالف(     

 نمودار می توان جلوگیری کرد؟از نمایش کدام یک از موارد زیر،  مربوط به  -13

 ( همه موارددالف( عنوان                              ب( راهنما                               ج( محورها                                      

 از کدام گزینه استفاده می شود؟ صعودیبرای مرتب کردن داده های موجود در سلول ها به ترتیب  -12

 Subtotalد(                                   Filterج(                   Descendingب(                     Ascending( الف    

 کدام عملگر مقایسه ای است؟ -12

 &د(                                         ^ج(                                    +ب(                                  < >( الف    

 ویروس



29-    If we use count Function,which Function shows highest value? 

 Averageد(                                   Maxج(                          Highestب(                                 sum (الف    

 Powerpoint 1332ارایه مطالب 

 کدام گزینه  دارای دستورات مدیریت فایل ها است؟ -23

 Insertد(                                 Designج(                  Office button ب(                       Homeالف(             

 چیست؟  Note pageکاربرد ناحیه   -22  

 جهت یادداشت نكته یا تذکر      ج( جهت تغییر بزرگ نمایی             د( برای نمایش وضعیت اسلاید ها (ب     الف( برای نمایش اسلاید ها             

 استفاده می شود؟ Insertبرای درج پیوند ،  از کدام دستور زبانه   -21   

 Chartد(                              Wordartج(                          Smart Artب(                  Hyperlink( الف           

 استفاده می شود؟ Insertبرای درج دکمه های عملیاتی ،  از کدام گزینه زبانه ی   -22  

  Actionد(                             Smart Artج(                              shapes( ب                        Pictureالف(          

 ،  از کدام گزینه استفاده می شود؟ Slide showجهت عدم نمایش یک اسلاید در نمای  -22 

 Custom slideد(                       Current slideج(                         Hide slide( ب            Narration Slideالف(         

     35- Where your video clip plays when you clicked? 

 video playerد(                   in powerpoint(ج      in windows media playerب(                      in slideالف(         

 

 ACCESSبانک اطلاعاتی 

 ود؟استفاده می ش بعدی، برای رفتن به رکورد  Access، در نرم افزار   Findاز گروه  Gotoکدام گزینه در منوی  -23

 Lastد(                             Previousج(                                          Next( ب                                Firstالف(         

 معرف کدام گزینه است؟ نام خانوادگیبا در نظر داشتن پایگاه داده اطلاعات شخصی دانش آموزان،   -22

 د( پایگاه دادها     یلد                                  ب( رکورد                                         ج( جدول                                (  فالف       

 ظاهر شود، از کدام گزینه برای آن فیلد استفاده می شود؟ لیست انتخابیاگر بخواهیم هنگام ورود اطلاعات برای یک فیلد ،    - 22

 Memoد(                              Look up ج(                                         Textب(                       OLE objectالف(       

 استفاده می شود؟ برای ذخیره اعداد اعشاری با دقت معمولی ، از چه نوع داده ای    -22

 Single( د                               Doubleج(                                      Integerب(                                  Byteالف(       

 پس از ایجاد بانک اطلاعاتی خالی، اولین جدول در چه نمایی باز می شود؟ -23

 Pivot chartد(                          Pivot tableج(                                      Designب(                         Data sheet الف(      

 مقادیر یک فیلد عددی به کار می رود؟ میانگین کدام دستور برای محاسبه -22

 Maxد(                                    Sumج(                                     Average( ب                                  Minالف(       

42-  You can use a form to ……. Data from a table query. 

 all of themد(                                    editج(                                        display( ب                                enterالف(       



 نیستند؟ Wordفرض محیط های زیر جزء اجزای پیش.کدام یک از گزینه12

 کش د: خط          Tableنوار ابزار  ج:ب: نوار مرور قائم                   Standardالف: نوار ابزار    

 دهیم...را فشار می………….  برای انتقال به ابتدای پاراگراف قبلی کلید ترکیبی 12

 ↓+Ctrlد:    ↑+Ctrlج:            Ctrl+Endب:           Ctrl+Home الف:  

 رود؟.  کدام کلید ترکیبی میانبر برای افزایش سایز قلم به کار می12

  (+Shiftد:             )+Shiftج:                  [+Ctrl: ب                       ]+Ctrlالف:   

 ؟نمی شودمورد نظر استفاده  Font. کدام روش برای انتخاب 23 

  Ctrl+Dالف: فشردن کلید ترکیبی   

   Formatاز منوی   Fontب: انتخاب گزینه   

 Formattingاز نوار ابزار   Fontج: انتخاب فونت مورد نظر از طریق گزینه   

  Ctrl+Fفشردن کلید ترکیبی   د:   

 بندی یک یا چند کاراکتر به صورت نمایی ) توان ( استفاده می شود؟.  از کدام گزینه برای قالب22

 Paragraphاز کادر محاوره  Subscriptب: گزینه        Fontاز کادر محاوره  Subscriptالف: گزینه   

 Fontاز کادر محاوره  Superscript: گزینه د     Paragraphاز کادر محاوره  Superscriptج: گزینه   

 رود.به کار می ………برای  Format Painter.  ابزار 21

 : کپی کردن قالب بندی یک پاراگراف به یک یا چند پاراگراف دیگربالف: کپی کردن یک پاراگراف از محلی به محل دیگر       

 ج: جابجا کردن یک پاراگراف از محلی به محل دیگر          د: حذف پاراگراف  

 

 های زیر انتخاب شوند؟.  برای تعیین کلید میانبر برای یک سبک لازم است به ترتیب کدام فرمانها و گزینه22

 Format  | Style | Modify | Shortcut Key: : ب     Tools | Style | Modify | Shortcut Keyالف:   

 Format | Auto format | Options | Shortcut Keyد:            Format | Style | Modify | Hot Keyج: :   

 باشد..می……….  یكی از روشهای اعمال تورفتگی به یک پاراگراف استفاده از 22

 های الف و بد: گزینه                Fontکادر محاوره  ج:ب: خط کش قائم                     الف: خط کش افقی  

 

 رود..به کار می………….  مفهوم الگو برای تسریع و تسهیل در تولید اسناد 22

 د: متنی        : دارای وجوه اشتراک    ج: کاملاً متفاوت از همب           الف: کاملاً شبیه به هم  

 . کلید میانبر باید الزاماً :23

 : ترکیبی باشد.د  باشد. Shiftب: غیر ترکیبی باشد.     ج: شامل کلید  باشد.    Altالف: شامل کلید   

 شود؟ . برای اعمال کلید میانبر به سمبل یا کاراکتر ویژه مورد نظر، از کدام قابلیت استفاده می22

 Symbolه از کادر محاور Autocorrectب: دکمه           Symbolاز کادر محاوره  Shortcut Keyدکمه  الف:  

 د: همه موارد              Toolsاز منوی  Autocorrectج: فرمان   



 باشد؟ترین نما برای صفحه آرایی سند چه نمایی می. مناسب22

 Normalد:    Outlineج:          Print Previewب:   Print  Layout:الف  

 شود. ..استفاده می………برای  Go To.فرمان 22

 ب: انتقال نقطه ورود به محلی مشخص    شی از متن به محل دیگرالف: انتقال بخ  

 و ج ب  د: گزینه های   احضار محلی مشخص از سند در صفحه نمایش  ج:  

 رود؟. کدام گزینه برای تعیین فاصله زمانی ذخیره خودکار سند به کار می23

 Optionاز کادر  Saveدر زبانه   Save Auto recovery Info Every: گزینه الف  

 Optionاز کادر  File Locationدر زبانه  Save Everyب: گزینه   

 Optionاز کادر  Generalدر زبانه  Save Auto recovery Info Everyج: گزینه   

 Optionاز کادر  Generalدر زبانه  Save Everyد: گزینه   

 ین کاراکترها قابل استفاده است؟برای تنظیم فاصله ب Font. کدام گزینه از کادر محاوره 22

 Spacing د:  Effectsج:         Positionب:    Kerning Fontsالف: 

 . کدام قسمت ناحیه وظیفه را می توان برای تولید اسناد جدید به کار گرفت؟21

 Clipboardب: ناحیه وظیفه     Styles And Formattingالف: ناحیه وظیفه 

 Searchد: ناحیه وظیفه      New Document: ناحیه وظیفه ج

 ،   . کاربرد دکمه های روبروکدام است؟   22

 تغییرجهت نوشتن ازچپ به راست      -الف: ایجاد لیستهای شماره دار

 تغییر جهت نوشتن از چپ به راست  -ب: ایجاد لیستهای علامت دار

 غییرجهت نوشتن از راست به چپ     ت –علامت دار : ایجاد لیستهای ج

 تغییرجهت نوشتن از راست به چپ -ایجاد لیستهای شماره دارد: 

 نیست؟. کدام جمله در مورد الگوها صحیح 22

 الف: جلوگیری از کارهای تكراری در سندهایی که فرم یكسان دارند.    

 ذخیره کنیم. Dotب: برای ایجاد الگو کافی است سند را یا پسوند  

 : در یک فایل الگو امكان ایجاد جدول وجود ندارد.         ج

 را انتخاب می کنیم.    Templateگزینه  New Documentد: برای استفاده از الگوها در کادر  

 برای ایجاد عناوین )تیتر( چیست؟ Word. سبک پیش فرض 22

 Footerد:                    Headerج:           Headingب:              Normal: الف

 . کدام جمله در مورد سبكها صحیح است؟23

 می توان برای سبک دلخواه یک کلید میانبر تعریف کرد. ب:الف: امكان تعریف سبک جدید وجود ندارد.                



 ل اعمال و تعریف نیست.ج: در تعریف سبک امكان تغییر رنگ قلم وجود ندارد    د: تنظیمات سبک برای قالب بندی پاراگراف قاب

 . کدام یک برای تنظیمات پاراگراف قابل استفاده است؟22

 Edit>Paragraphد:           Edit>Fontج:      Format>Paragraphب:        Format>Fontالف: 

 ی گیرد؟مورد استفاده فرار م Font. برای تغییر تنظیمات فونت )قلم( فارسی کدام گزینه در کادر محاوره ای  .48

 Complex Script د:             Outlineج:          Font styleب:          Latin Textالف: 

 . با انتخاب کدام گزینه متن حالت برجسته پیدا می کند؟22

 Under Lineد:                 Shadowج:          Subscriptب:          Emboss: الف

 چیست؟ Wordدر کادر محاوره ای  Default. . نتیجه استفاده از دکمه 23

 ب: تایید تنظیمات جدید فقط برای سند جاری    الف: لغو تنظیمات جدید و اعمال تنظیمات قبلی   

 اتد: بستن کادر تنظیمات بدون در نظر گرفتن تغییر  : تایید تنظیمات جدید برای تمام سندها بطور پیش فرض      ج

 



Word 2007 

 برای ذخیره ی فایل جاری با نام جدید از کدام گزینه ا ستفاده می شود ؟

 Openد(   Closeج(   Save as( ب   Save( الف

 با استفاده از گزینه ی ............................ می توان برای متن خود سایه قرار داد .  Fontدر کادر 

 Shadow(د  Sub Scriptج(  Out lineب(  Super Scriptالف(

 میشود؟ انتخاب  printer درکادر گزینه کدام است شده انتخاب که سند ازیک خاصی محدوده چاپ برای

 pageد( current pageج(    Allب(  selectionالف(

 

 برای ادغام چند سلول در جدول از .............. استفاده می کنیم

 Split Table د(  Split cell ج(   Merge cell ب( Insert cell الف(

 

 میكنیم؟ دستورزیرراانتخاب کدام Insert واززبانه Header and footer ازگروه صفحه شماره درج برای

    show document text ب(   page number (الف

 footer د(    Header ج(

 

 جهت درج فهرست مطالب کدام گزینه را انتخاب می کنیم ؟

    Insert table of figures ب(  Table of contents (الف

 Hyperlink د(    Book mark ج(

Excel 2007 

 برای شمارش تعداد سلولهای عددی انتخاب شده از کدام تابع زیر استفاده می شود؟

 Count number(د  averageج(    Maxب(  Sumالف(

 

 کدام قسمت چاپ می شود ؟   Printدر کادر Active Sheet(s)با انتخاب گزینه ی 

 ب( سلول های انتخاب شده  الف( کل کار پوشه 

 د(همه ی کاربرگ ها  ( کاربرگ های فعال ج

 برای ثابت نگه داشتن تیتر جداول از کدام دستور استفاده می شود؟

 unfreeze( د                      freeze( ج                             splitب(          arrangeالف( 

 

 .کنیم استفاده سطریاستون ازاسم قبل............ ازعلامت کافیست مطلق به نسبی دهی آدرس تبدیل برای

 !د(   $(ج    ctrlب(   @الف( 

 

 برای نشان دادن عدد به صورت درصد باید از ....................استفاده شود.

 textد( Percentage(ج   Currencyب(  numberالف(

 

 به کاربرگ اضافه می کند ؟ نمودارکدام گزینه یک 

   Insert  Diagrams ب(   Insert Charts (الف

 Insert Picture د(   Insert  Shapes ج(

Power Point 2007 

 به منظور  ایجاد الگوی اسلاید ها از ................................ استفاده می کنیم . 

  Slide Sorter د( Slide  Normal   ج(  Slide Master (ب  Slide Show(الف

 استفاده می شود ؟  Insertبرای درج پیوند از کدام دستور در زبانه ی 



 

Word 2007 

 که درآن حاشیه ها دیده می شود کدام است ؟  Word2007پر استفاده ترین نمای برنامه ی 

 Print Layout ب(    Outline viewالف( 

 Web Layoutد(      Draftج(

 انجام شده از کدام کلید ترکیبی اشتفاده می شودبرای لغو اخرین عمل 

  ctrl + cد(  Alt + zج(   ctrl + z(ب  ctrl + yالف(

 به کدامیک از موارد زیر می توان کادر اضافه نمود؟

 هر سه مورد صحیح است(د یک پاراگراف                   ج(یک سلول مشخص                ب(یک جدول               الف(

 تعداد نسخه چاپی از سند را در مقابل کدام گزینه مشخص می نماییم ؟

  Number of copies(ب     Pagesالف(

 Selectionد(                    Scale to paper sizeج(

 برای جستجوی یک عبارت در متن از کدام گزینه استفاده می شود؟

 bookmark د(   goto ج(   replace ب(  find (لفا

 برای درج کاراکترهای ویژه که روی صفحه کلید نمی باشد از کدام گزینه استفاده می شود ؟

 character د(  chart ج(   wordart ب(  symbol (الف

Excel 2007 

 کدام است ؟   Excel 2007پسوند فایل های ذخیره شده در محیط 

 exclد(    xslsج(    xlsx( ب   xlsالف( 

 می کند  ؟ گردکدام تابع عدد ورودی را 

 Pmtد(   Intج(   Averageب(  Round(الف

 .ابزاراصلی برای مرورهمزمان قسمت های مختلف یک کاربرگ...............است

 unfreeze( د                      freezeج(                               splitب(           arrangeالف( 

 Chart د(   Word art ج(   Hyperlink (ب  Smart art الف(

 جهت اعمال جلوه های فانتزی به متن .......... را انتخاب و جهت درج اشكال ........... را انتخاب می کنیم . 

   Shapes – word Art Styles ب(   Shapes – Text Effects (الف

 Shapes – Paragraph د(  ShapesChart - Text Effectsج(

 چگونه باید عمل کرد؟ Power Pointموجود در  کلیپ هایبرای درج فیلم ویدوئی از 

  Insert Play CD Audio Track ب(    Insert  Movie from file الف(

 Insert  Movie from clip organizer د(    Insert  Sound from file ج(

 جذاب مناسب تر استکدام گزینه برای ایجاد یک متن با جلوه گرافیكی 

    Word Art (ب   Smart Art الف(

 Text Box د(    Clip Art ج(



 

 به کاربرگ اضافه می کند ؟ نمودارکدام گزینه یک 

 Pictureد(  Shapes ج(   Diagrams ب(  Charts(الف

 بكارمی رود؟ پولیکدام نوعِ  داده برای مقادیر 

 textد(     Percentageج(   Currency(ب  numberالف(

 

 کدام قسمت چاپ می شود ؟   Printدر کادر Active Sheet(s)با انتخاب گزینه ی 

 د(همه ی کاربرگ ها   ( کاربرگ های فعال ج        ب( سلول های انتخاب شده  الف( کل کار پوشه 

Power Point 2007 

 نام پیش فرض صفحات درنرم افزارپاورپوینت چیست؟

 presentationد(     defultج(   bookب(   Documentالف(

 

 استفاده می شود ؟  Insertبرای درج پیوند از کدام دستور در زبانه ی 

 Chart د(  Word art ج(  Hyperlink (ب   Smart art الف(

 با انتخاب کدام گزینه  format backgroundدر هنگام تغییر پس زمینه اسلایدهای نمایشی درکادرمحاوره ای 

 نمایش اعمال کرد؟ میتوان ترکیبی ازدورنگ متفاوت را به زمینه

 Gradient fill(د Hide background graphicsج( picture or texture fillب( solid fillالف(

 

 برای افزودن دکمه عملیاتی به اسلایدازکدام گزینه استفاده می کنیم؟

  Action button (ب  Animationالف(

 Setup slide showد(  Slide transitionج(

 برنامه نمایشی ازکدام یک ازنماها استفاده می شود؟برای اجرای 

    Slideshow(ب    Normalالف(

 Slidesorterد(    Notepageج(

 

 Power point 2007 ج(

 .شودکدام نما برای مرتب کردن اسلایدها استفاده می  (1

 Slide viewد(               Normalج(           Slide Sorter(ب              Slide Showالف(

 .شودبرای درج شکل های گرافیکی از کدام گزینه استفاده می  (2

 Viewد(                    Header ج(                      Shapes(ب                      Pictureالف(

 .کدام گزینه به جلوه های گذر اسلاید اشاره دارد  (3



 Transition(د                 Showج(                  Designب(                     Effectالف(

 .شودبرای درج دکمه های عملیاتی در اسلاید از کدام گزینه استفاده می  (4

 Action Buttons(د              Custom Animationج(                 Slide Transition ب(             Hide slideالف(

 .شودسفارشی از کدام گزینه استفاده میبرای ایجاد یك نمایش   (5

                     From Current Slideب(                     Custom Slide Show    (الف

 Record Narrationد(                               Setup Slide Showج( 

 

 

 Excel 2007 د(

 

 .دهد چه عملی انجام می  Mergeگزینه  (6

 جا دادن متن در سلولد(                حذف قالب بندی سلولج(                ادغام سلول(ب                        تقسیم سلولالف(

 .دهدچه عملی انجام می Countifتابع   (7

                     منفیشمارش تعداد سلول های دارای مقادیر ب(                     شمارش تعداد سلول های دارای شرایط خاص(الف

 محاسبه مجموع سلول های دارای شرایط خاصد(                     شمارش تعداد سلول های دارای مقادیر مثبت ج( 

 .برای نمایش رکورد هایی که یک یا چند فیلد آن شرایط خاصی دارد، کدام دستور مناسب است  (8

 Auto-Sumد(                                Viewج(                        Filterب(                        Subtotalالف(

 .شودبرای گرد کردن اعداد از کدام تابع استفاده می  (9

 Round(د                                 PMTج(                         Countب(                              INTالف(

11)  Page Order  باشدتعیین کننده کدام مورد می. 

 چاپ صفحات زوج و فردب(                 ترتیب چاپ صفحات(الف

 WorkBook    یک  Sheetترتیب چاپ د(           عناوین چاپ                  ج( 

  Word 2007 (ه

 .شودبرای ایجاد یک جدول به روش ترسیم از کدام گزینه استفاده می  (11

 Delete Tableد(                     Convert Tableج(                      Insert Tableب(                     Draw Table(الف

 .شودبرای تنظیم حاشیه های سند ازکدام دکمه استفاده می  (12

 Orientationد(                           Margins (ج                               Size ب(                            Columnالف(

 .شودبرای افزودن کادر به صفحه از کدام گزینه استفاده می  (13

 Watermarkد(                   Line Numberج(                    Page Borderب(                   Page Break الف(



 .باشدچه می Word 2007( در Templateپسوند فایل های الگو)  (14

 Dotد(                                 Txtج(                               Dotx(ب                              Docxالف(

 .شودبرای زیر نویس کردن یک یا چند کاراکتر از کدام گزینه استفاده می  (15

 Shadowد(                       Outlineج(                     Subscriptب(                  Superscriptالف(

 .شودبرای ایجاد متونی به حالت گرافیکی و جذاب ازکدام گزینه استفاده می  (16

 Word Art(د                     Text Boxج(                        Smart Artب(                          Shapeالف(

 Access 2007 (و

 .برای وارد کردن مقادیر متنی طولانی مثل توضیحات کدام نوع داده مناسب است  (17

 Attachmentد(                     OLE Objectج(                      Textب(                     Memoالف(

 .کدام است Access 2007پسوند فایل های بانک اطلاعاتی در   (18

 mdbد(                            acc2007ج(                               accdb (ب                                       dbالف(

 .کدام مشخصه از فیلد ها قانونی را برای ورود داده ها تعیین می کند  (19

 Input maskد(                   allow Zero lengthج(               Validation Rule(ب               Validation Text الف(

 .نمی کندرا در رکورد جستجو  11تا  5کدام گزینه مقادیری بین    (21

                       and <=10 5=<ب(                                                In(5,6,7,8,9,10)الف(

 between 5 and 10د(                                                      or <=10 5=<(ج  

 .در کدام نما جزئیات طراحی فرم قابل مشاهده هستند  (21

 Form Layoutد(                    Design View(ج                   Form Viewب(                  Layout View الف(

 .میانگین مقادیر یک فیلد عددی بکار می رودکدام دستور برای محاسبه   (22

 Maxد(                              Sumج(                         Average(ب                          Minimumالف(

 .کاربر را مجبور به وارد کردن ارقام در محل قرارگیری آن می کند Input maskکدام کاراکتر در نمای   (23

 صفر(0 ( )د                                  ? (ج                                   a ب(                                        Aالف(

 

 Powerpoint 2007ارایه مطالب 

 را یک ............. می گویندوباپسوند ................ ذخیره می شود. 2117هرفایل پاورپوینت 

PPtx-Persentation (د          PPtx-Document)ج          Ppt-slide)ب     Ptx-Spreadsheet)الف 

 برای درج جدول در اسلایدها از چه زبانه ای استفاده می شود؟

Design د(                    Home ج(                            Insert (ب                        View)الف 



 استفاده می شود؟ Insertپیوند از کدام دستور زبانه  برای درج

Chart                )د Word Art)ج                    Smart Art ب(                 Hyperlink (الف  

 برای ایجاد اسلاید جدید ازکدام کلید ترکیبی استفاده می شود؟

Ctrl+L د(                   Ctrl+M (ج                           Ctrl+N ب(                    Ctrl+W)الف 

 توسط کدام یک از کلیدهای زیر، شروع نمایش از اسلایدجاری انجام می شود؟

F10)د                         F5 ج(                        Shift+F5 (ب                 hift+F10)الف 

 میتوان یک آرم را در تمام اسلایدها اعمال کرد؟با استفاده از کدام نما 

Slide show)د             Slide view)ج               Slide master (ب            Slide sorter)الف 

 کدام نما برای مرتب کردن اسلایدها استفاده می شود؟

Slide Show)د           Slide Sorter (ج                       Normal)ب             Slide View)الف 

 Word 2007واژه پرداز

 کدامیک از گزینه های زیر برای کپی قالب بندی یک پاراگراف واعمال آن به پاراگراف دیگراستفاده می شود؟

Replace د(                      Style ج(                            Copy ب(       Format painter (الف  

 چیست؟ Referenceدر زبانه  Insert Foot noteمورد استفاده دکمه 

 ( درج پاصفحه              ب( درج پاورقی                   ج( درج یادداشت             د( درج پیوندالف

 استفاده می شود؟  Printبرای چاپ صفحه جاری، کدام گزینه از کادر محاوره 

Selecion)د                        All ج(                   Even page ب(         Current page (لفا  

 درکدام زبانه قرار دارد؟  Spelling & Grammarفرمان

Home)د                     View)ج                          Insert)ب                 Review (الف  

 است؟کدام گزینه مقدار پیش فرض تب 

 سانتی متر 1سانتی متر           د( 2.27سانتی متر              ج( 1.27(بسانتی متر            1.5الف(

 برای تقسیم وادغام خانه ها به ترتیب از کدام فرمانها استفاده می شود؟



Insert – Merge)د       Split – Merge (ج               Merge – Split)ب     Insert – Delete)الف 

 برای مشاهده تعداد کلمات موجود دربخشی ازمتن کدام گزینه استفاده می شود؟

     Word Count( کادرمحاوره د       Researchج(              Line Numberب(         Outlineالف(نمای 

 

 نمره 52.0سوالات چهارگزينه اي هر كدام 

 ميشوند؟ ذخيره فرمتي نوع چه با پيش فرض صورت به فايلها -1

  ) Dotx د Xlwx                           )ج) Doc                         ب Docx                         ( الف 

 کرد؟ استفاده ميتوان  Save Asمنوي  زير ازکدام الگو صورت به سند يك ذخيره براي -2

     Word 2003 Document د( Other Format            ج(          Word Document ب( Word Template        ( الف

 قراردارند؟ کليدها کدام برروي کليد صفحه روي کوچك برآمدگيهاي سريع، تايپ براي -3

 F,K د( D,K                               ج(                                       F,J  ب(                                     D,Jالف( 

 در تورفتگي چيست؟ First Line کاربرد  -4

 پاراگراف  چپ سمت تورفتگي پاراگراف                                              ب( اول خط تورفتگي (الف

 پاراگراف راست سمت تورفتگي پاراگراف                   د( اول خط از غير خطوط همه ي تورفتگي ج(

 است؟ مناسب ميانبر کليد کدام قلم، کردن پر تو براي -5

 Ctrl + B د(                            Ctrl + U ج(                                Ctrl + Iب(                           Ctrl + G الف(

 است؟ مناسب بالا انديس به متن تبديل براي ويژه جلوهي کدام -6

 All Caps د(                  Superscript(  ج                      Small Capsب(                     Subscriptالف(  

 است؟ گزينه کدام تب پيش فرض مقدار -7

 سانتيمتر 1.27(د                  سانتيمتر          2.27 سانتيمتر                            ج( 5.5سانتيمتر                         ب(  1 الف(

 .ميكنيد انتخاب را ................ فرمان ديگر، کلمه اي جاي به کلمه يك جايگزيني براي -8

 Replace All د( Search                   ج(                     Findب(   Replace            (  الف

 کدام است؟ Cutعمل انتقال  کليد ميانبر -9

 Ctrl + U د(                                 Ctrl + V ج(            Ctrl + X (ب                     Ctrl + C الف(

 کرد؟ ايجاد روزنامه اي متنهاي ميتوان گزينه کدام با -15

 Header And Footerد(                             Paragraphج(                      Tabب(                        Column(الف

 ميكند؟ تنظيم ايستاده و عمودي را کاغذ جهت گزينه کدام -11

 Portrait د(                     Page Setupج(                Layoutب(             Landscapeالف(  

 براي متن چيست؟ Wordسبك پيش فرض  -12

   Heading د(                                         Titleج(               Normal ب(                 Footnoteالف( 

 ميشوند؟ ذخيره فرمتي چه با الگو فايلهاي -13

 Dotc د( Doct                        ج(                    Docxب(                             Dotx(  لفا

 براي چيست؟ Word Optionsدر پنجره ي   Check Spelling As You Typeکاربرد گزينه ي   -14

   Spelling & Grammarب( باز کردن کادر                                                       اشكالزدايي الف(

 متن روي رمزگذاري د( خودکار                                                    تصحيح (ج

 



 

 

 نمره 52.0سوالات چهار گزينه اي  هر كدام 

 ميكند؟ تنظيم افقي و خوابيده را کاغذ جهت گزينه کدام -1

 Portraitد(                        Layoutج(               Landscape(  ب                    Page Setupالف( 

 ميگيرد؟ قرار استفاده مورد Page Layoutزبانه ي  در گروه کدام کاغذ جهت و حاشيه ها تنظيم براي -2

 Page Setup د(                  Paragraphج(                    Themeب(    Page Background        الف( 

 ميشود؟ ستوني چند متنهاي بين در جداکننده خطوط آمدن وجود به باعث گزينه کدام -3

 Column د(             Right To Leftج(           Line Between  ب( Number Of Columns        الف( 

 نمي باشد؟ مناسب سرصفحه کردن غيرفعال براي روش کدام -4

 هيچكدام( د         Header And Footerراست کليك روي ج(             Closeانتخاب صفحه   ب(   وسط در کردن کليك الف( دابل

 است؟ مناسب حاشيه ها تنظيم براي زبانه کدام  -5

 Page Layout (د                              Insertج(           View ب(Home        الف( 

 است؟ مناسب گزينه کدام سند متفاوت براي صفحات زوج و فرد صفحه ي پا و سرصفحه ايجاد براي -6

 Header And Footer د(     Page Setupج(      Different Odd And Even Pages(  بDifferent First Page        الف( 

 ميكند؟ کمرنگ بسيار را زمينه متن گزينه کدام -7

 Picture Watermark د(     Text Watermark(  ج              No Watermarkب(  Watermark        الف( 

 به کار مي رود؟ Footerو  Headerبين  حرکت براي کليد کدام -8

  Tabد(                                    ج(                                          ب(                         ( الف

 

 نمره1سوالات چهار گزينه اي  هر كدام 

 مي شود؟ استفاده گزينه کدام از مستقل جدول دو به جدول يك تقسيم براي -1

 Split Cellsد(              Merge Tableج( Merge Cells       ب(           Split Table( الف        

 مي کند؟ اضافه انتخابي سطر بالاي به سطر يك گزينه کدام -2

   Insert Rows Below ب(                                         Insert Rows Above( الف  

 Insert Column To The Left د(                          Insert Column To The Rightج(    

 مي دهد؟ قرار شده حذف سلول جاي به را پاييني سلول هاي و مي کند حذف را سلول دستور کدام -3

        Shift Cells Right ب(                                    Delete Entire Column الف(   

 Shift Cells Up (د                                              Delete Entire Row ج(    

 مي کند؟ حذف را ستون ها دستور کدام -4

 delete rowد(         Delete Columns( ج       Delete Table ب(     Delete Cells الف(    

 کدام دستور براي ادغام سلو ل هاي جدول استفاده مي شود؟ -5

 shift cells downد(         insert entire rowج(           Merge cells( ب          split cellsالف(     

 نمره1سوالات چهار گزينه اي  هر كدام 

 مي شود؟ استفاده گزينه کدام از مستقل جدول دو به جدول يك تقسيم براي -1

 Split Cellsد(              Merge Tableج( Merge Cells       ب(           Split Table (الف       



 مي کند؟ اضافه انتخابي سطر بالاي به سطر يك گزينه کدام -2

   Insert Rows Below ب(                                          Insert Rows Above( الف

 Insert Column To The Left د(                          Insert Column To The Rightج(  

 مي دهد؟ قرار شده حذف سلول جاي به را پاييني سلول هاي و مي کند حذف را سلول دستور کدام -3

        Shift Cells Right ب(                                    Delete Entire Column الف( 

 Shift Cells Up (د                                              Delete Entire Row ج(  

 مي کند؟ حذف را ستون ها دستور کدام -4

 delete rowد(         Delete Columns( ج       Delete Table ب(     Delete Cells الف(  

 کدام دستور براي ادغام سلو ل هاي جدول استفاده مي شود؟ -5

 shift cells downد(         insert entire rowج(           Merge cells( ب          split cellsالف(   

 

 

 نمره1سوالات چهار گزينه اي  هر كدام 

 كدام گزینه است؟  Distribute Columnمفهوم كلمه  -1

 يكسان سازي( ب                                        سطرها يكسان سازي الف( 

    ستون ها

ستون  پهناي يكسان سازي د(                               ارتفاع سطرها يكسان سازيج(  

 ها

 مي شوند؟ اضافه Ribbon به زبانه ها كدام جدول، رسم از بعد -2

 – Layoutب(                                 Layout - Design (الف    

Format      

 – Design د(                                       Format - Design ج(

Developer 
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